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Advanced Design System 2017 Update 1.0 Release Notes
For general information about Advanced Design System (ADS), visit ADS webpage at http://www.keysight.com/�nd/eesof-ads.

Starting ADS 2017 Update 1.0,we have made an important change to the ADS Major Update Releases. This change may impact your decision to install and use
ADS 2017 Update 1.0.  
For more information, see Important Information about ADS Update Release.

From ADS 2017 release, the Linux system requirements has been updated:

Support for  5.x has been discontinued.
Updated the system libraries and rpm �les. Following is the list of minimum patch versions required:

 6.8
Redhat 7.2
Suse 12 SP2
Suse 11.3

Running ADS with installed patch versions lower than the above recommendations will only cause a few features to not work properly.

For more information, refer to Supported Platforms.
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Signal Integrity/Power Integrity

PIPro

PIPro DC Analysis setups now include VRM sense line connections with simulation results added to the results table, and power tree. 
DC and AC Analysis schematic test bench generation can now include sense lines for use with higher �delity VRM models.
Improved rendering performance for e�ciently working with large (40 cm x 40 cm or larger) PCB designs. Use OpenGL2 graphics and the performance
rendering settings to get the best results.
Extended the DC solver in PIPro AC Analysis to improve low frequency accuracy.

SIPro

SIPro accuracy upto 40 GHz.
Enhanced the Unconnected pad feature.
Accurate simulation results are obtained when a full board is simulated.
Smooth transition for saved SIPI views not having the net extraction when enabling it.
Improved port de�nitions and calibrations have been added to reduce parasitic e�ects that have a negative impact on the phase accuracy in SIPro. Sheet
port distributions are now used at internal port locations.

Via Designer

Pad and antipad dimensions can be set ‘per layer’.
A  is created when a feed is on a plane layer.
The etch angle parameter from the substrate is read. Transmission lines with trapezoidal cross sections can be modeled.

Known Issues

For more information, see SIPro and PIPro.

 Back to New Feature Updates

Design Editing

Implemented Keepout object feature that de�nes an area where traces, vias, components, and metal (for example, ground planes) should not go.
Currently only the metal keepout is implemented. For more information, see Creating Keepout.
Created new WINDOW_GEOMETRY environment variables that will allow you to save and restore window positions for all the types of ADS windows, for
multiple monitors, maximized/minimized/normal state, and 4K displays. For more information, see Customizing the ADS Environment.

Known Issues

Agilent Technologies

Redhat

Redhat

Coplanar Waveguide
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For more information, see Schematic Capture and Layout.

 Back to New Feature Updates

Circuit Simulation

DDR

Added DjRj, Dual-Dirac, and PWL jitter pro�le options to the Tx and Rx models for DDR Bus simulator. The new jitter PDF related parameters are now
supported in the con�g �le.
Device clock o�set can now be speci�ed from the target data rate (in ppm) in Tx_AMI, Rx_AMI, XtlkTx_AMI, ReDriver_AMI and ReTimer_AMI components.
New IBIS examples added in this release and searchable using Example Search.
You can now Encrypt/Decrypt DDR5 Tx/Rx Equalization con�guration from a �le. For more information, refer to DDR Con�guration File Encryption.
You can now request for an average and user de�ned vertical location of the eye mask for DQ lines.

SerDes

Back Channel Training 
Allows Tx and Rx to communicate and train each other to tune the equalization settings in order to optimize signal integrity (SI).

For more details on Back Channel Training, refer to the Back Channel Training page.

NXP SiMKit Models

The models have been updated to SiMKit Release 5.0 (April 2018), and these are now the default.

For more information, including supported device versions, see Devices and Models, NXP SiMKit.

Known Issues

For more information, see Using Circuit Simulators.

 Back to New Feature Updates

FEM Simulation

Mapping of port distribution lines to mesh elements in FEM are now more robust.

Known Issues

For more information, see FEM.

 Back to New Feature Updates

Verification 

Assura DRC Link

Assura DRC supports rule categories (switches). The DRC dialog box detects the Assura DRC con�guration in the PDK and populates the Rules tab
with rule categories.
New AEL functions for con�guring Assura DRC in a PDK. For more information, see DRC Functions Library Con�guration.
Assura DRC can be run in batch mode.
Assura DRC results can be imported into the DRC dialog box.

For more information, see Using Assura DRC Link.

ADS DRC  

Performance improvements for large layouts.

 Back to New Feature Updates

Power Electronics

Improved convergence

The Transient Convolution and Harmonic Balance simulators have been enhanced to improve convergence with typical switched-mode power supply circuits.

Power Electronics Library

Power Electronics (PE) Library requires the W2375 Power Electronics Library license, or a bundle license containing W2375 Power Electronics Library such
as W2240 Power Electronics Bundle: ADS Core, TC, PE Lib, Layout, Momentum.

You may see in ADS that it is referring to W2370 for Power Electronics Library license; this is a typo on the error dialog box and we need
to consider this as W2375 instead of W2370.

The library contains components speci�cally built for Power Electronics including components for closed loop feedback regulation of switched-mode
power supplies (SMPSs). For example, the Pulse Width Modulator works with both the Transient Convolution and Harmonic Balance simulators. The
component palette also provides easy access to ADS built-in component that are often used in power electronics.

Descriptions of each of the components are summarized in the table below.

Components included on the Power Electronics Palette

Component Description

Pulse Width
Modulator

Specially designed to work in both Transient Convolution and Harmonic Balance simulation. Harmonic Balance simulator gives the
periodic steady state solution without a lengthy power-up transient and is particularly valuable in closed loop analyses such as loop
stability in the presence of noise such as conducted EMI.

http://edadocs.software.keysight.com/display/ads2017update1/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017update1/DDR+Configuration+File+Encryption
http://edadocs.software.keysight.com/display/ads2017update1/.Backchannel+Training+v2017Update1.0
http://edadocs.software.keysight.com/display/ads2017update1/Devices+and+Models%2C+NXP+SiMKit
http://edadocs.software.keysight.com/display/ads2017update1/Using+Circuit+Simulators
http://edadocs.software.keysight.com/display/ads2017update1/FEM
http://edadocs.software.keysight.com/pages/viewpage.action?pageId=461662700#DRCFunctions(bycategory)-libconf
http://edadocs.software.keysight.com/display/ads2017update1/Using+Assura+DRC+Link


Component Description

ASM GaN
transistor
model

The ASM GaN transistor model was recently standardized by an industry body, the Compact Model Coalition (CMC). ADS supports
models created by your power device vendor and by  model generation tools: W8598BP Power Electronics Model Generator,
PD1000A Power Device Measurement System for Advanced Modeling, and the W8538EP IC-CAP GaN Power Electronics Modeling
Add-on.

SiC
PowerMOS
transistor
model

ADS supports SiC PowerMOS models created by your power device vendor and by Keysight model generation tools: W8598BP Power
Electronics Model Generator, PD1000A Power Device Measurement System for Advanced Modeling, and the W8536EP/ET IC-CAP SiC
PowerMOS Power Electronics Modeling Add-on.

Insulated
gate bipolar
transistor
(IGBT) model

ADS supports IGBT models created by your power device vendor and by  model generation tools: W8598BP Power
Electronics Model Generator, PD1000A Power Device Measurement System for Advanced Modeling, and the W8537EP/ET IC-CAP
IGBT Power Electronics Modeling Add-on.

Generic Gate
Driver

This component is a useful placeholder in the early stages of a design, before a vendor-speci�c gate driver has been selected. Once a
speci�c component has been selected, you can replace this one via the netlist importer. We support ADS, PSPICE, , HSPICE,
Spectre, and Berkeley dialect of SPICE decks.

Generic
MOSFET
model

As with the generic gate driver above, this component is a useful placeholder in the early stages of a design, before a vendor-speci�c
power device has been selected. Once a speci�c component has been selected, you can replace this one using the appropriate
model card. Unlike ideal switch component, this model is continuously di�erentiable. Unlike simple Berkeley SPICE models like Level
1 MOS, this model conserves charge. Together, these improve simulation convergence. In addition, this model is close to a physically
realizable transistor. In contrast, ideal switch is, in general, not physically realizable.

Non-linear
magnetics

Physics-based model of winding, air gap, and hard and soft ferromagnetic core. Implements a modi�ed Jiles-Atherton core model
that is more simulator-friendly than other implementations, with improved accuracy. You can specify the core saturation and
hysteresis behavior either from a) the traditional J-A parameters (saturation magnetization, M_s; magnetization reversibility, c;
domain wall density, a; pinning break average energy, k; interdomain coupling, alpha) or b) from measurements extracted from the
B-H curve. You can create a simple inductor or a complex multi-tap transformer using MMF/�ux magnetic circuits.

The parameters extracted from IC-CAP in a .mps �le format could be directly imported into ADS. A model card of the extracted model is placed on the
schematic and populated with the extracted parameters. Power devices ASM_HEMT, PowerMOS_SiC_Keysight and IGBT_Keysight are supported by IC-CAP
import option. This feature could be accessed from ADS main window, Tools > IC-CAP Import > Power Devices.

 Back to New Feature Updates

Verification Test Benches

Upgraded the version of the SystemVue engine to SV 2018 in ADS. 
ADS 2017 update 1 only supports import of Custom VTB (SystemVue workspace) created using SystemVue 2018.
Added the following new VTBs:

5G Advanced Modem Workspaces 
3GPP_NR_DL_Tx
3GPP_NR_DL_Tx_Source
3GPP_NR_UL_Tx
3GPP_NR_UL_Tx_Source

NB IoT Workspaces
LTE_Advanced_NBIoT_DL_Tx
LTE_Advanced_NBIoT_UL_Tx

Updated the name of the existing VTBs:
WLAN 11ac Workspaces

ReferenceSensitivity_Analysis updated to WLAN11ac_ReferenceSensitivity_Analysis
Tx_1Ant_Analysis updated to WLAN11ac_1Ant_Analysis
Tx_1Ant_Source_Analysis updated to WLAN11ac_1Ant_Source_Analysis

 Back to New Feature Updates

Examples

All the newly added examples are searchable using the Example Search dialog box.

Known Issues

For more information, see Working with Example Workspaces.

 Back to New Feature Updates

Licensing

ADS  requires: a) the version 2018.04 of the EEsof EDA licensing software, b) a minimum code-word version 2018.04 or above, and c) the licensing server
software, lmgrd and agileesofd, to be upgraded to at least the same versions as what are included in EEsof EDA Licensing software 2018.04. ADS All-
Versions will not start if any of these requirements is not met. Refer to the License Codeword Version Compatibility Table.
In the EEsof EDA License Tools version 2018.04, licensing vendor daemon (agileesofd) is integrated with FlexNet FNP 11.13.1.4 version ( ) and
FlexNet FNP 11.13.1.3 version (Linux) of  license manager daemon (lmgrd). For the Windows platform, ADS installer will automatically set up these
two new license server daemons by default for the local node-locked license users; for the Linux platform, you need to follow the Linux/Solaris Licensing
Setup instruction to complete the licensing con�guration process. For more details, refer to Licensing (For Administrators).

Known Issues

For more information, see Licensing (For Administrators).

 Back to New Feature Updates

Known Issues

Signal Integrity/Power Integrity - Known Issues

Keysight

Keysight

LTspice

Windows
FlexNet
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Designs with hatch patterns may lead to slow response time of the SIPro/PIPro window. Depending on the complexity and size of the hatch pattern
metalizations, the SI or AC simulation will likely lead to unrealistic memory requirements as the hatch patterns are simulated as is. A manual simpli�cation
step of the hatch patterns is the workaround solution in this case.
In case of a mesh failure during an PIPro/SIPro simulation, you can consider one of the following actions as a workaround:

Change the resolution option to a smaller or larger value.
Change the Arc resolution to a smaller value (e.g. 45 or 30 degrees).
Locate the area in the layout indicated by the mesh process and make a small change in the layout in this area, e.g. removing any metal when it is
irrelevant for the simulation. A small change may be su�cient to make the mesh process successful.

System requirements on Linux:
On , you need at least glibc-2.12-1.183
On RHEL7, you need at least glibc-2.17-104
On  12, an update to SP2 is needed

In Via Designer, using a variable for the backdrill stub length with a nominal value of 0 has no e�ect in sweeps.  
Workaround: Specify a nominal value di�erent from 0 and toggle the backdrill checkbox.
ADS 2017 is not compatible with the following libraries:

Murata_Lib_ads2011later_1610e_dynamic
Murata_lib_ads2011later_1703e_static library
Samsung_Library_v411

 Back to Feature Updates

EM Simulation - Known Issues

General

EM simulation with CDF components:
Not integrated with the history management systems available in CDS Design Management Momentum.

The simulation temperature and conductor temperature coe�cients are not yet taken into account in an FEM simulation.
The layermap �le, even if it has only a comment, is required to import ICT �les.

Momentum

On fast PC/laptops with McAfee Endpoint Security enabled, the Momentum EM solver may terminate unexpectedly reporting a �le access
problem. McAfee ENS seems to be unable to cope with the speed Momentum opens/closes �les. 
Workaround: Disable McAfee Endpoint Security’s real time scanner or consider upgrading to McAfee ENS 10.5.2 or later.

FEM

The FEM LSF cluster simulation may fail with the error "Cannot �nd a license �le or connect to a license server". 
Workaround: Specify the ADS license �le or server in the �le .eeso�ic in your home directory on the LSF cluster. This can be done by adding a line of the
form  
ADS_LICENSE_FILE=<license �le name or server name> 
to the .eeso�ic �le.
FEM simulations, viewing �eld and current plots in the 3D viewer are not supported when the workspace path has international characters.  
Workaround: The FEM simulations can be executed if the name of the simulation directory speci�ed in the EM Setup Resources tab is set to a location
without international characters.
System requirements on Linux:

On RHEL6, you need at least glibc-2.12-1.183
On RHEL7, you need at least glibc-2.17-104
On  12, an update to SP2 is needed

3D EM Preview does not show in�nite ground planes or slot layers, this does not a�ect the Momentum or FEM simulations.
The combination of the resource setting Parallel jobs for frequency sweep >1 with one of the automatic mesh re�nement frequency options "Chosen
automatically after initial pass" or "Chosen automatically after each pass" is invalid and will cause a simulation failure when used.  
Workaround: use sequential frequency sweep or select a �xed re�nement frequency for the mesh re�nement.
In case issues are seen when launching (failing FEM simulations) on  6 systems, the following environment variable can be set to avoide the problem:
"EESOF_NO_LIBTCMALLOC: setting it to 1.
EM distributed simulation prompts a failure message when a simulator is still active and you try to fetch data from a partially completed simulation
directory.
In case of getting python error messages and failures when running any FEM on RHEL operating systems, perform the following system check  operations:

Run the ./linux_sys_check.sh tool which comes with the ADS/EMPro installation and �x any issues reported by the tool (e.g. missing system
libraries)
If this does not address the problem, check that the system requirements on Linux are met.

If a failure occurs when launching FEM simulations to a remote simulation service on RHEL7 (For example, Simulation Error: Solve process failed wirh
return code: -6”):

Stop any running simulation services
Create a new shell where the DISPLAY environment variable has been unset: unset DISPLAY
Start a new simulation service from this shell

If an FEM simulation fails on a Windows system with McAfee Endpoint Security, disable the “Enable Adaptive Thread Protection” option.

 Back to Feature Updates

Circuit Simulation - Known Issues

Gemini simulation stops working, if you upgrade to  and try to run the simulation with the already installed ADS 2017 version.
Workaround: Uninstall and re-install ADS 2017.

Electrothermal Simulator in ADS Layout

If you get licensing errors while running thermal simulation, you may need the following workaround. 
Workaround: Rename the �le  $HOME/.eesofrc. For example,  $HOME/.eesofrc-orig.

Electrothermal does not support remote simulation, batch simulation, Monte Carlo, tuning, Optimization, Measurement Equations and sweeping of the
global temperature variable. Also, you cannot sweep directly on the DC controller.
All libraries referenced in a layout should use the same layout resolution, namely the OA database units (DBU) per user unit (UU).
You cannot run both a transient and envelope simulation on the same design from one testbench.
The calculation of power dissipation from passive components other than resistors may not be correct in harmonic balance simulations.
Electrothermal does not support the transient or envelope simulation that is controlled by a ParamSweep.  

RHEL6

SUSE Linux Enterprise Desktop

SUSE Linux Enterprise Desktop

RHEL

Windows 10



If you get "Maximum timestep reduced to half of shortest transmission line delay " warning, it can lead to transient simulation to not converge    
 Workaround: Unselect "Limit timestep for Transmission Line" option on Time Setup tab of Tran component to get it work.
On Linux, if you specify the THERMAL_DIRECTORY variable in eesof_lib.cfg �le using backward slash (..\thermal), the thermal simulation does not run
properly. 
Workaround: Specify the THERMAL_DIRECTORY variable using forward slash (../thermal) instead of backward slash.
The ETH viewer does not support 4K displays. A few instances of text and icons may appear distorted. 
You receive an error message in substrate editor that you cannot use the same layer number more than once. You can safely ignore this error during
thermal technology export.
On a fresh  system, Electrothermal simulation terminates with an error.  
Workaround: Install the following  runtime components:  

https://www.microsoft.com/en-in/download/details.aspx?id=30679  
https://www.microsoft.com/en-in/download/details.aspx?id=5555

GGTools and Dynamic Link

Cadence IC 5.1.41 (and other  versions without 64-bit MPS libraries) will not work for GGTools and Dynamic Link. The rfdemp (GGTools) and idfmp
(Dynamic Link) executable �les are linked to Cadence 64-bit libraries. Only Cadence versions with 64-bit em_sh, mpsc_sh, cdsCommon_sh, and sman_sh
libraries are supported. Supported Cadence versions are listed in $HPEESOF_DIR/idf/supported_cadence_versions.txt.
Workaround: Use ADS 2013.06, 2012.08 or earlier versions of ADS for GGTools or Dynamic Link when using Cadence IC 5.1.41. Alternatively, Cadence IC
5.1.41 libraries can be converted to Cadence IC 6.1.4 or newer versions to use GGTools and Dynamic Link in ADS 2014.01.
Dynamic link: ADS Output probing does not works with Virtuoso schematic.
While performing iRCX import the technology �le without '.tf' extension gets deleted automatically, if the technology �le and momentum module name
are same and are present at the same location. 
Workaround: Before performing iRCX import, make sure the PDK technology �le name has the '.tf' extension.

NXP SiMKit Models

Older versions of ADS would ignore any "version" parameter, and simply use whatever version of SiMKit that was included in that version of ADS.  Now
that ADS is paying attention to this parameter, simulation results may not be identical to that of older ADS releases.

The "version" parameter is only supported from the netlist (e.g.,  netlistInclude  components), using ADS and spectre syntaxes.  There is no
support for setting this parameter from the schematic.
The version value can only be speci�ed as a direct numeric value.  It cannot be speci�ed indirectly via a variable or an expression.  For more information,
see "Devices and Models, NXP SiMKit".

Components

User-Compiled Models

Documentation: Do not install Vendor Libraries or Design Kits under $HPEESOF_DIR, otherwise the associated help links will not work.

Encoded Component is not simulated if uselib line is mentioned as  #uselib “libName”, “compName”. 
Workaround: Modify the uselib line of instance netlist format of the encoded component as follows: 
#uselib “libName”, “compName_libName”    
Where,

libName  - name of the encoded library
compName  - name of the netlist �le or schematic

High Speed Digital (HSD)
On fast PC/laptops with McAfee Endpoint Security enabled, submitting jobs to run in parallel via the Simulation Manager may not work.   
Workaround: Disable McAfee Endpoint Security’s real time scanner while using the simulation manager for parallel simulations on Windows.

RF/Microwave

To use VTB, ensure ADS is installed in a path that has only .
Simulation error detected by hpeesofsim in loading Verilog-A device during netlist parsing, though Verilog-A �les are placed in “<PDK>/veriloga” directory
of a PDK. '#load' command failed to �nd `xxx.va' in the simulator's model search path. 
Workaround:  Place Verilog-A �les (xxx.va) in the location:<PDK>\circuit\models  to overcome simulation error in ADS2014.01, ADS2015.01, and
ADS2016.01.
Verilog-A simulation is not working when ADS 2016.01 is used to perform simulation in ICCAP.
Verilog-AMS is not supported on SUSE11 platform using ADS 2014.01.
While sharing through the product , the second circuit simulation can hang the running ADS session. 
Workaround: Change or add the registry entry HKEY_CURRENT_USER\Software\WebEx\AppSharing\DisableSharingIndicator to be equal to zero. The
following is reg �le example for this setting: 

 Editor Version 5.00 
[HKEY_CURRENT_USER\Software\WebEx\AppSharing] 
"DisableSharingIndicator"=dword:00000000
Certain user-compiled MINT models are not threadsafe. 
Workaround: You should recompile the model or run the simulation as single threaded.
In some cases, the Transient Simulations might be slow 
Workaround: You may set DefaultConvStart=0 on the analysis line to use the default convergence mechanism.
Before tuning or optimizing the AMI parameters, check that the AMI model parameter values are in valid range.

“: No such �le or directory.” error message may occur on compiling MINT or User Compiled models (UCM) on 64-bit Linux platform.

Workaround: Ensure the make/con�g �les do not have Windows line endings on the Linux platform.

Users performing simulations from the command-line, or ADS GUI simulations that use  #include'd netlists, may encounter issues (such as multiple
de�nition errors) due to a di�erent naming scheme used with include �les. Before, the netlister would use a scheme like this for the (example) include �le,
"/path/to/file":

#ifndef inc__path_to_file   #define inc__path_to_file inc__path_to_file    
#include "/path/to/file"    
#endif    
This has been changed to: 
#ifndef inc__YqZ_path_YqZ_to_YqZ_file    
#define inc__YqZ_path_YqZ_to_YqZ_file 1    
#include "/path/to/file"    
#endif    
 
Included netlists that use the old scheme may encounter errors, as the old scheme may no longer prevent multiple inclusions of the same �le. 
 
Workaround: Move the  #ifndef/#define/#endif  statements to each include �le (surround the include �le contents).

Budget analysis might fail if ADS is installed on  platform. 
Workaround: Use other supported platforms.

Windows 10
Microsoft Visual C++

Cadence

ASCII characters

Cisco Webex

Windows Registry

Windows 8
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For MATLAB cosimulation, MATLAB 2012 and 2013 have problems, and  2014a works correctly.
SystemC cosimulation does not support 64 bit ADS.
SystemVue design with integer array parameter does not work in ADS as VTB.
Expressions used in custom VTBs for plotting Graphs are not handled in ADS.

 Back to Feature Updates

Platform - Known Issues

Ctrl+F4 hot key to close current window is not working on Linux if KDE GUE is used.
When running ADS on linux and displaying it on a remote system, in some con�gurations, some graphics drawing such as displaying menus are slower
than on ADS 2013.06 and prior releases.

Workaround: Launch ADS with "-graphicssystem" as a command line option to the "ads" startup script. If you are using an X11 connection over ssh, the "-
C" option compresses the data and can improve drawing performance.
When a project is converted to workspace, there is a chance that string type parameters of some components may show invalid values. To get the correct
parameter values, open the Component Parameter dialog box, click the editable parameter and click Apply. If a large number of components need to be
modi�ed please contact Keysight for better support.
Users running ADS under  remote desktop tools Exceed onDemand and NoMachine  can see under Schematic and Layout windows,  while zooming using
the middle mouse wheel, ADS ignores pointer selection. Instead of zooming that pointed instance it just zoom  panned selected area away from the
original mouse clicked point.

Workaround:  Set an environmental variable WARP_VIEW_VIRTUALLY to be FALSE  e.g.   export WARP_VIEW_VIRTUALLY=FALSE

AEL

Iterators are now reference objects. This means that any changes to an iterator will modify all copies, even if the iterator is being treated as a value. Below
is the type of code which is a�ected:

    decl iter = db_create_inst_iter(context);

    decl selectedInstIter = db_inst_iter_limit_selected(iter);

In previous releases, the above code represents two iterators: iter and selectedInstIter.  Now there will only be one iterator in the code above,
and that iterator will limit to selection.  Any existing AEL code that attempts to use both iterators separately will need to be corrected.  Going forward, the
above code example can be written this way instead:

    decl iter = db_create_inst_iter(context);

    db_inst_iter_limit_selected(iter);

The second call will modify the iterator directly. 
Another case where this is important is when saving the current object from the iterator.  In the past, it was possible (but very ine�cient) to simply save
the entire iterator:

    decl iter, shapeList; 
    for (iter = db_create_shape_iter(context); db_shape_iter_is_valid(iter); iter = db_shape_iter_get_next(iter)) 
        shapeList = append(shapeList, iter); // Inefficient in 2016.  Invalid in 2017: The iterators in the list will be modified i

Instead, the last line should be:

        shapeList = append(shapeList, db_shape_iter_get_shape(iter)); 

           Each type of iterator has a similar db_xxxx_iter_get_xxxx() function which gets the current object from the iterator.

Printing 

Postscript output is no longer supported. To generate Postscript utilize a PDF to PS converter (a number of these converters are available online and for
download).
Selection of custom paper sizes is now supported directly in the ADS printer interface.
On the windows platform changing the paper size in the "Advanced Printer Setup" dialog will produce incorrect output.  On the Linux platform correct
results are generated.
When using an SVG or PDF �le generated using the ADS printer interface in other applications the fonts used in the �le may not be found by the other
application. When this occurs the text will be displayed using a di�erent font that may not appear to be the same size as the original font used inside ADS.
This is caused by the other application not being able to �nd the ADS fonts used in the SVG or PDF �le. To workaround this issue install the ADS fonts into
the local systems font con�gurations using the "fontcon�g" or "xset" commands. The ADS fonts are located in the "$HPEESOF_DIR/lib/fonts" directory.

PDK Builder

PDK Builder is not fully functional on Linux.
From ADS 2016.01, on the Linux platform you need to add $HPEESOF_DIR/bin in the  LD_LIBRARY_PATH.
If a PDK is re-generated using the PDK Builder at the same location as was created earlier, the technology library inside this PDK will be deleted. 
Workaround: Delete the PDK before re-generating it at the same location, through the PDK Builder.
When packaging a PDK using PDK Builder, the ‘zip’ option doesn’t work.

Workaround: Create a PDK and then manually zip it.
The PDK Builder still creates folders named ‘linux_x86_64_GCC462’, ‘win32_64_VS2010’ and ‘win32_VS2010’ inside the ‘bin’ folder of the generated PDK.
However for ADS2015.01 the compilers have been updated. So these folders should be renamed to – ‘linux_x86_64_GCC472’ and ‘win32_64_VS2012’ for
ADS2015.01 UCMs. There is no replacement for the ‘win32_VS2010’ folder, since ADS2015.01 is not supported on Windows 32 bit.

International Character and Space Supportability

Artwork translators do not support spaces and international characters.
Mentor’s DxDesigner does not support international characters. When cells named with international characters are transferred to Mentor, the
international characters gets modi�ed.
In case of Budget Simulation, when user tries to open the results of simulation (.csv �le) with international characters,  gives the incorrect
�lename error. 
Workaround: Ignore the incorrect �lename error; open the �le manually to view the results.
DRC AEL Rule �les (like “drc.ael” or “spacing.ael”) cannot contain international characters in the name. It otherwise works well with the international
characters.
LVS AEL Rule �les cannot contain international characters in the name. It otherwise works well with the international characters.
IP Encoder does not support spaces in the destination encoded library name. 
Workaround: Specify a library name that does not include spaces.

 Back to Feature Updates
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Documentation - Known Issues

On Windows, Printing directly from Qt Help generates non-readable output. 
Workaround: Use PDF version of the document for printing purpose.
From ADS 2016.01 onwards, in ADS help when you open a page using the "Open a link in new tab" option the help does not opens a page in di�erent tab
by default. You need to set the preferences to open any link in a new tab. 
To set the preferences:

1. From the ADS 201x (or the installed version) Help, Click File > Edit > Preferences. 
The Preferences Dialog box is displayed.

2. Select the Options tab.
3. Under Appearance, select the Show tabs for each individual page option.

This is one time setting for a particular release of a product.
Unable to open online help, any external link, or Embedded Survey link in Linux on  browser. 
Workaround: Use  version 39 or above or keep the Firefox window open and then try to open online help.
ADS online help is not supported on the . 
Workaround: Use  or Firefox version 39 or above to view ADS documentation.
If the ADS help does not show any content, throws an error, or does not display any search results. 
Workaround: Close the help and delete the contents of the following directory:

On : C:\Users\<Windows_Login_ID>\AppData\Local\Keysight\Help

On Linux: $HOME/.local/share/Keysight/Help

ADS   search does not support [] or {} or any other text using these combinations.

 Back to Feature Updates

Examples - Known Issues

Example search might not work and prompt you the "Database is locked" error when ADS installation is on NAS. 
Workaround: Restart the nfslock service on client. In case the problem still persists, reboot the client to unlock the database.

Unable to compile Pin Diode Model using  on Windows 7 64-bit platform. 
Workaround: Delete the contents of the directory examples\RF_Microwave\UserCompiledModel_wrk\ UserCompiledModel\lib.win32_64 before
using UCMs.
An error occurs while running a custom VTB. 
Workaround: Download and run a custom VTB from the following location: <ADS Install Location>\SystemVue\2016.08\win32_64\VTB.

 Back to Feature Updates

PDKs - Known Issues

Error/warning reporting has been made stringent w.r.t incorrect information in ‘library.tech’, which holds the layer display information. If warnings are
seen regarding “�ll patterns”, “line style” or others, the information in ‘library.tech’ �le needs to be corrected. Loading the custom �ll patterns be avoided,
starting ADS 2017. For more information, see Adding Custom Fill Patterns to a Design Kit.
The public AEL function to convert a DSN-based PDK to an OA-based PDK, de_convert_design_kit_to_oa(), is obsolete beginning this release.
Workaround: Use ADS 2016.01 to convert a DSN-based PDK to OpenAccess.
The Modelithic Kits needs to be compiled with the latest compiler version used with ADS 2016.01 i.e gcc492 (for Linux) and VS2013(for windows).
If you make changes in the View-Speci�c Con�guration tab of the Design Parameters dialog box, an itemdef.ael �le may get created in the cell of the
component. You can ignore this and delete it if you don't require demand loading. The Item de�nitions will be loaded as they were prior to this �le getting
created.
The PDKs created by RFIP Encoder still contains some �les and folders which are obsolete in the ADS 2011 and onwards. You can ignore them.
ADS may issue a warning message requesting that you contact your foundries for an updated PDK. This warning message appears when popping out of
the design hierarchy in a layout window, or using the Edit > Component > Update Component De�nitions menu option. We are working closely with
foundries to update these PDKs. PDK Users can determine whether a PDK needs to be repaired by calling
de_check_and_report_pcell_parameters_in_library() from the ADS Command Line. If you are the owner of a PDK, you can �x the PDK using
de_update_pcell_parameters_in_library(), as described in the PDK Documentation. 

 Back to Top

Licensing and Installation - Known Issues

Licensing
License Setup wizard may not be able to start license server with many license �les. During setup, it may lead to a situation where a command
prompt window appears/disappears incessantly. This is due to the fact that License Setup wizard is not able to start lmgrd with a long command
line and may get stuck in a loop. 
Workaround:  

1. It is recommended to combine all license code words tied to same MAC ID into single license �le to avoid setting large number of license
�les.

2. Try to use a shorter path to place license �les.
3. If #1 and/or #2 does not help, start the license server (lmgrd.exe) from the command line (e.g. lmgrd.exe -c <lic-�le-path> -l

<license_server_log.txt>) and then set <PRODUCT>_LICENSE_FILE=<PORT-NUMBER>@localhost for product you want to use on same PC.

Dongle drivers for Flex-10 dongles on Linux are release speci�c. Installing the latest dongle drivers on Linux will function properly only for the most
recent EEsof releases. 
Workaround: Install and use dongle drivers as needed.  If you need to run the most recent EEsof releases, use the latest  Flex-10 dongle driver. If
you need to use older releases, uninstall the latest dongle driver and re-install the older dongle driver
FLO and EEsof License setup are writing server logs at di�erent locations. However, the EEsof server log �le location is updated in the License
Manager > Environment tab.
When multiple same-named INCREMENT lines of di�erent version exist on the license server, few advanced  options to reserve/limit
licenses may not work properly. 
Product Selector “Check Availability“ generates incorrect results (which leads to license failure) for older releases when multiple date base versions
of like-named bundles exist in the license pool.
In Linux, Product Selector OK and Cancel Buttons locations are reserved.
Starting from  2015 (also known as version 11.13.1), the adoption of the best practice of the least-privilege security therein results
in the License Server related Windows Service to run with the LocalService Account privilege (instead of the LocalSystem privilege as before.) 
Running with the LocalService Account privilege, an executable can no longer access any �les located in the per-user speci�c type of folders.  As a
result, any license �le placed in those folders can no longer be accessed by the License Server when the License Server is automatically started via
the Windows Service upon each PC reboot. For the local node-locked license, this would not result in any disruption to the usage of EEsof
applications; however, for the license installed on a network PC that is accessed by multiple client PCs, this may cause EEsof applications not to
start after the network PC reboots 
Workaround: Store your license �les in the Windows folders that are accessible by the LocalService Account privilege.  For example,
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Google Chrome browser
Internet Explorer

Windows 7

Qt

Visual Studio 2012

FlexNet
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C:\ProgramData or C:\users\public are both quali�ed choices.  In general, any folder that has the "Users" group listed in its Properties > Security
page and this "Users" group has the read permission enabled should work. 
Using the default port to connect to a license server may cause a delay when checking out licenses. If no port is given in the license �le, Flexera
scans ports 27000 to 27009 to �nd the port. Starting from  2015 (aka version 11.13.1), the default timeout for the response from
each port increased from .1 seconds to 3 seconds.

To avoid the delay, KSM now issues licenses with port 27009 instead of leaving this blank. The EEsof License Setup Wizard (from Licensing 2017.01
onwards) handles some common situations such as: where it detects license �le(s) without port, when users get a new license �le with port 27009,
or when all license �les for a vendor daemon does not have same port.

You will not be able to start the license server if all license �les for a vendor daemon on a server does not have same port.

Users who manually setup a license server or using EEsof License Setup Wizard with older licensing bits may need to manually edit license �les to
comply with the following rules:

1. All license �les for a vendor daemon on a server must use the same port (or all be blank). 
2. Using the default port (blank) is allowed but may result in longer checkout times. 
3. If setting up a network server, select an unused port that is not blocked by a �rewall.

Workaround: If the user cannot change the port, or wants to use the default Flexera ports, the environment variable FLEXLM_TIMEOUT can be set
to .2 seconds (200000), to minimize the performance degradation. However, if the network latency is an issue in your environment, you may need
to �ne-tune this setting to minimize the general performance degradation while still accommodating the network latency.
Installation of EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) may hang at 4% (percentage vary based on the
products) for few hours or even more on some speci�c machines. 
Workarounds:

Disable Firewall setting in Anti-Virus Software installed on the PC. 
or
Download and unzip  from the below link and then invoke procexp.exe. 
https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx 
Right click on the wusa.exe process under <Product installer exe> and select KillProcess. Now it will continue the product installation.

After installing EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) successfully and try to invoke the software or
License wizard, you may encounter “api-ms-win-crt-runtime-l1-1-0.dll” missing error. 
Workaround: Install the Update for Universal C Runtime in Windows .  On Windows 64-bit system systems, the �le to install is x64 version of the

 hot�x KB2999226. A copy of the Windows6.1-KB2999226-x64.msu  64-bit hot�x installer can be found under
the C:\Program Files\Keysight\EEsof_License_Tools\bin directory.  The Microsoft hot�x KB2999226 can be found under the
Update for Universal C Runtime in Windows  page at  https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-
windows as well.
On a newly formatted RHEL system, the EEsof Licensing tools may fail to boot. This is because the FlexNet Publisher 2015 requires a certain rpm 
Workaround: Under the EEsof product installation directory, there exists a utility script named "Linux_sys_check.sh" under the bin directory. Run
this script to �nd out whether any rpm is missing; run this script with a "-y" command-line option to also have all the missing rpms
automatically installed if you have the sudo or root privilege.
License server may stop recognizing Flex-10 dongle on some systems within a few hours after starting  
Workaround: If you experience this problem, install the latest WibuKey drivers from Wibu Systems.
Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a machine 
Workaround: Before installing a Flex-10 driver for the �rst time, unplug the Flex-9 dongle.
There is a known FlexNet Publisher issue, whereby mixing node-locked codewords and �oating codewords in one license �le can result in: a)
Remote simulations not working or b) A second local simulation not working in case the license is node-locked and also has incorrect version. 
Workaround: It is strongly recommended that you do not mix node-locked codewords and �oating codewords in one license �le nor
in any con�guration that ends up with node-locked codewords and �oating codewords both available on the same server. In other words, put the
node-locked license and the �oating license on di�erent servers, and point to the respective one based on what you need to run.
If a user simultaneously runs two instances of a product and has mixed di�erent versions of the same codeword on one license server, extra
licenses may be pulled and result in unexpected “Licensed number of users already reached for this feature” errors. 
Workaround: We recommend you remove expired codewords, to separate out the new and the old versions of codewords into di�erent �les and
di�erent servers, and to point to the respective one based on what you need to run.
Not specifying the TCP/IP port for the license server during license setup may lead to unexpected behavior and/or license checkout failure on the
Windows platform. We strongly recommend you to always explicitly specify the TCP/IP port associated with each license server.
A node-locked and �oating bundle operating on Linux cannot be shared between products using EDA License Tools version older than 2014.01
when run at the same time.
License Setup Wizard does not remove any previous user-con�gured FLEX Windows License Service manually set up by a user using FlexNet's
lmtools.  
Workaround: You must remove the previous user-con�gured Windows License Service via lmtools.

Run the lmtools.exe from C:\Program Files\Agilent\EEsof_License_Tools\bin to invoke the lmtools utility. The lmtools
utility window is displayed.

If you have installed an EEsof product released before 1st August, 2014 on your system prior to installing an EEsof
product released after 1st August, 2014 then the default EEsof Licensing tools path will remain C:\Program

Files\Agilent\EEsof_License_Tools. On the systems that only have EEsof products released after 1st

August, 2014 installed then the default EEsof Licensing tools path will be C:\Program
Files\Keysight\EEsof_License_Tools.

In the Service/License File tab, check the Con�guration using Services option. All user-con�gured FLEX Windows License Services will be
listed.
Select the service you wish to remove.
Select the Con�g Services tab and click the Remove Service button to remove the service. 
To ensure that the license service or lmgrd is running, click View Log. A log window appears that con�rms
whether agileesofd and lmgrd are up and running.

While running multiple versions of prior ADS releases together, set ADS_MAXIMUM_BUNDLE_USAGE=ON in your environment so that all of them
will use the same method to check out licenses. Otherwise, you might receive an error message, "Licensed number of users already reached".
On some  machines, when more than one de�nition of an  exists (duplicates), license checkouts may appear to hang
up. 
Workaround: Disable the duplicate network card de�nitions in your network settings: Control Panel > Network and Internet > Network
Connections. This issue has been acknowledged by Flexera and they have created a bug report (SIOC-000103097).

For LSF style distributed simulations, ensure that the PATH on the client computer points to the {architecture}
directory that corresponds to the EEsof release being used. This needs to be done in order to ensure that the proper version of the Flexera utilities
(like lmutil ) gets picked up in the path before any older in-compatible versions (that may also be installed on a users’ system.)
License Setup Wizard ( aglmwizard.exe ), which is used to set up and record the license path would not work if you already have an environment
variable set for ADS_LICENSE_FILE. 
Workaround: You can use ADS_LICENSE_FILE variable to point to license �le or refer to Licensing (For Administrators).
The License Setup Wizard will exit or not properly con�gure a license server, if the server has all of its licenses currently in use. 
Workaround: Wait for a license on the server to become available as you normally would before launching the product.
Unable to set license in case unicode characters are used either in path or license �le name because the Flex License Service does not support
these characters.
The Product Selector tool will be unable to display the license server status properly when connected to older license server. 
Workaround: Upgrade your license server to the latest version.
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EEsof Licensing Tools installer can hang on systems with McAfee LiveSafe installed and running the default �rewall settings. 
Workaround:  Prior to installing EEsof Licensing Tools, temporarily turn o� the McAfee LiveSafe �rewall.
Licensing setup steps on systems with McAfee LiveSafe installed can fail. 
Workaround:  Under the McAfee LiveSafe �rewall settings, under Port and Settings, allow the use of port 27001 for lmgrd.exe under the EEsof
Licensing Tools installation bin directory.  Under Internet Connections for Programs , enable lmgrd.exe, aglmmgr.exe and aglmwizard.exe for all
devices and turn o� monitoring.
On Windows, EEsof product releases prior to 2014 can have boot time issues with licensing if an newer EEsof product is installed prior to installing
the older product. For example, if a users installs Advanced Design System 2017 and then installs Advanced Design systems 2014.01, the user can
have boot time errors with ADS 2014.01. 
Workaround:  For Advanced Design System users,  set a system environmental variable named ADS_LICENSE_FILE under the Control Panel/
System, and Security / System / Advanced system settings and under the "environmental variables".  Add an  named
ADS_LICENESE_FILE and the value will be the path to your local license �le or the port@host setting for your site.

 Back to Feature Updates

Installation

While installing a new version of ADS, if you see “Previous version detected” error even after you have already run the uninstaller for that version of ADS,
you may need to manually uninstall ADS before installation of the new ADS. To manually uninstall ADS, perform the following steps.

1. Exit the current ADS installation session if it is running
2. Remove or rename the �le .com.zerog.registry.xml under the folder  C:\Program Files\Zero G Registry . Both the folder and the �le are by default

hidden, so you may need to change the folder viewing setting to show hidden �les and folders, do so via the Advanced settings of the View tab in
the Windows Folder Options dialog box.

3. Remove the ADS installation directory through the Windows Explorer.

             After performing the above steps, you can re-start the ADS installer.

On Windows 10, uninstall ADS option is sometimes missing under the Start > Advanced Design System 2017 option. 
Workaround: Uninstall ADS from Control Panel, "Uninstall a program" option.
On Linux, EM simulations will fail to start if you use international characters in the installation directory path. 
Workaround: Do not use international characters in the installation path.
While installing on Linux, if you see a prompt of "to insert Disk1”, it generally means the downloaded image has been corrupted. One of the likely causes
of such a corruption could be due to insu�cient local hard disk space. Be sure to specify a folder that contains adequate disk space when you
perform the untar command.
Anti-virus Con�icts: ADS could report error during its installation time, bootup time, or during a simulation run if the hosting system has an anti-virus or
other security protection software installed. 
Workaround: Add the following list of executable �les (for products such as , McAfee or ) as the exceptions to
the anti-virus or security protection settings:

bin/hpeesofde.exe
bin/MomEngine.exe
bin/hpeesofdds.exe
bin/keysight-vacomp.exe
bin/hpeesofsim.exe
bin/win32_64/MomEngine.exe
bin/win32_64/hpeesofdds.exe
bin/win32_64/keysight-vacomp.exe
bin/win32_64/hpeesofsim.exe

If you install ADS on a RHEL 6 platform and receive a Gtk warning message on your terminal window, you can safely ignore that warning.  That warning is
likely caused by the lack of  Gnome or  window manager running on your Linux box. 
ADS installer might error out on your Linux system if that system has a lower limit on the open �le descriptors than what ADS requires.  To increase this
limit, consult your Linux administrator, or if you have the “root” privilege, follow the instruction shown in the error message.
On certain Windows 7, 64-bit machines where you have multiple versions of jre installed, ADS might not uninstall successfully. 
Workaround: Rename or remove the jre directory under the installation directory and run the uninstaller.
When running ADS if you notice that the fonts shown on ADS menus appear smaller than usual, change the following environment variable with the size
you desire, for example, EESOFQT_FONT_POINT_SIZE=14  
When running ADS via Exceed On Demand, if you notice that the keyboard arrow keys and numeric keyboard don’t function properly, ensure that you are
using Exceed on Demand version 13.8.6.x or newer, and that XkbExtension=1 is set under the Xcon�g setting.  Consult your Exceed On Demand
administrator for help.
When running ADS via Exceed On Demand, after running a EOD session for over 4 hours, if you �nd the menus under the ADS window are not
responding. 
Workaround: Download and install the latest Exceed on Demand service packs from .
When run in a VNC session, ADS might not open when the window manager is set to  (twm).  
Workaround: Switch to Gnome or  as the window manager will �x this problem. Consult your VNC administrator for making this switch via updating
the $HOME/.vnc/xstartup �le.
When run in a VNC session, ADS will not start if the  extension is not present in the X server.   
Diagnostic: You can run the following command to verify whether the RENDER extension is present: xdpyinfo | grep RENDER  
If the above command displays no results/output, the extension is not present, and you should consult your VNC administrator for upgrading your X
server and/or VNC server to have the XRENDER enabled.  There is no other workaround, other than to upgrade to a VNC server that supports the
XRENDER extension. 
If the above command shows "RENDER", then you have the  extension, and ADS should work.

On Windows, ADS crashes with attempts to do File > Open & other fundamental operations on newer  workstationsWorkaround:  Refer to ADS
2016.01 crashes on Dell workstations document on Knowledge Center.   

Slowness on Linux systems is observed while opening/closing ADS window.
Workaround: This could be due to AMD/am-utils utilities used on Linux systems. Use autofs utilities instead.
Unable to Invoke ADS when running via Citrix
Workaround: This issue is owned by  and has come up with a patch to �x the problem. Please contact  for support.
If ADS installer errors out with a message like "cannot create a virtual machine" or some other formats of java errors, follow the instruction below:  
Workaround 1:

1. Install the latest version of Java from , https://java.com/en/download/.
2. Open command prompt and run the following command, where the last argument is a working version of java.exe:
ads201X_XX_XXX.exe LAX_VM  "C:\Program Files (x86)\Java\jre7\bin\java.exe"

3. Restart the ADS installer.
Workaround 2: Perform the following settings and restart the ADS installer.

1. Click Start > Control Panel > System and Security.
2. Click  View basic information about your computer under System.
3. Click Advanced Systems Settings.
4. Click the  .
5. Under System Variables, click Add and add the following variable: 

Name: _JAVA_OPTIONSValue: -Xmx512M
6. Click OK.
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On new Windows 8.1 systems, ADS can fail to boot and prompt the System Error, “This program can’t start because api-ms-win-crt-runtime-l1-1-0.dll is
missing from your computer".Workaround:

1. Install the Microsoft Windows 8.1 Update for x64 systems KB2919355. This update is available here. See the instructions on this page, “These KB's
must be installed in the following order: clearcompression�ag.exe, KB2919355, KB2932046, KB2959977, KB2937592, KB2938439, and KB2934018.”

2. Re-install  2015 Redistributable from here.
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Working with Prior Releases - Known Issues

With older workspaces, a circuit simulation may fail during netlist �attening because of an apparent unde�ned device. This is due to a con�guration
variable, EESOF_MODEL_PATH,in the workspace's hpeesofsim.cfg �le that tries to locate the 32-bit versions of dynamically loaded devices. These are
no longer supported. 
Workaround:  

Delete the directories named .*ams_work (note the dot) which can be located under either the workspace directory, or $HOME/hpeesof.
Delete the directory $HOME/hpeesof/tiburonda-vams-model-cache.
Rename the existing hpeesofsim.cfg �le in the workspace, to something like, "hpeesofsim.cfg.old", and re-simulate twice . The �rst simulation will
quickly fail, because the �rst simulation will have already read hpeesofsim.cfg before it was renamed, but the second simulation should succeed.
Alternatively, you can quit and restart ADS.

In rare cases, existing layout designs containing components that reference a substrate (i.e have a Subst parameter) could be a�ected in this release. This
will only occur if:  

1. the substrate is either not speci�ed or is a PCSUB, and
2. the design’s technology uses layers with the same name as those in ads_standard_layers but with modi�ed layer numbers.

These types of components have been modi�ed to search for the layer by name before using a default number. In ADS 2016 and earlier, the layer name was not
used in these cases.
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